Infrastructure Navigator Installation and Administration Guide

vCenter Infrastructure Navigator 1.1.1

This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log in to the Infrastructure Navigator Web Console</td>
<td>28</td>
<td></td>
</tr>
<tr>
<td>Using Infrastructure Navigator Web Console</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td><strong>6</strong> Upgrading Infrastructure Navigator</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Infrastructure Navigator Upgrade</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Upgrade Infrastructure Navigator by Using Web Console</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>Upgrade Limitation for Infrastructure Navigator</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td><strong>7</strong> Uninstalling Infrastructure Navigator</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>Uninstall Infrastructure Navigator Plug-in</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td><strong>8</strong> Troubleshooting Infrastructure Navigator</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>vCenter Certificate Error</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Plug-In Does Not Work in vSphere Web Client After an Upgrade</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Error in Retrieving Information Might Occur</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Incorrect Marking of a Virtual Machine as an External Machine</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Deployment Failure After IP Address Change</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>Failure of the Virtual Appliance After DHCP Selection</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>VMware Tools Compatibility Error</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>Infrastructure Navigator Authentication Failure</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>Navigation Problem Between Objects</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Error Because of Single Instance of Infrastructure Navigator</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Navigation Error</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Discovery Failure in Linked Mode</td>
<td>39</td>
<td></td>
</tr>
<tr>
<td>Error Message in Recent Tasks List</td>
<td>39</td>
<td></td>
</tr>
</tbody>
</table>

Index 41
The VMware vCenter Infrastructure Navigator Installation and Administration Guide provides information about installing and configuring of VMware vCenter™ Infrastructure Navigator.

Infrastructure Navigator is an application awareness plug-in to the vCenter Server that provides continuous dependency mapping of applications.

**Intended Audience**

This information is intended for virtual infrastructure administrators who are familiar with virtual machine technology and datacenter operations.
Infrastructure Navigator Overview

VMware vCenter Infrastructure Navigator is an application awareness plug-in to the vCenter Server that provides continuous dependency mapping of applications.

Infrastructure Navigator offers application context to the virtual infrastructure administrators to monitor and manage the virtual infrastructure inventory objects and actions. Administrators can use Infrastructure Navigator to understand the impact of the change on the virtual environment in their application infrastructure.

**NOTE**  Plug-ins (also referred to as Extensions) expand the capabilities of vCenter Server by adding features and functionality to the base product.

This chapter includes the following topics:

- “Infrastructure Navigator Functionality,” on page 7
- “Infrastructure Navigator Target Users and Benefits,” on page 7
- “Infrastructure Navigator Architecture,” on page 8
- “Components of Infrastructure Navigator,” on page 8

**Infrastructure Navigator Functionality**

Infrastructure Navigator provides a centralized view of your application environment.

Infrastructure Navigator performs the following high-level functions:

- Maps virtual infrastructure resources such as virtual machines, Web servers, mail servers, database servers, application servers, cache servers, messaging servers, application management servers, and virtualization management servers.
- Displays relationships between virtual machines and external machines through services.
- Detects inconsistencies from the norm.
- Allows you to take advantage of integration with other VMware products such as VMware vCenter Server and VMware vCenter Site Recovery Manager (SRM).

**Infrastructure Navigator Target Users and Benefits**

Infrastructure Navigator creates a detailed model of the application environment and offers application context to its users.

Infrastructure Navigator helps virtual infrastructure administrators to accurately answer the following questions:

- Which application services are running on my virtual machines?
What are the dependencies among application services running on different virtual machines?
What are the hidden optimization opportunities and how can I capitalize on them?
How do certain application changes impact my environment?
What are the risks involved in making changes in the virtual environment?
How do certain virtual machine's issues impact application operation and how can I prevent or solve these issues?

Infrastructure Navigator Architecture

Infrastructure Navigator is a virtual appliance that you can import on the vCenter Server. A virtual appliance is a virtual machine image that contains software designed to run in a virtual machine.

With the components of Infrastructure Navigator, you can map services running in your virtual environment, examine the application discovery status, view and analyze the dependency map, and have a centralized view of the entire application environment.

The architecture illustrates various components of Infrastructure Navigator and their dependencies.

Figure 1-1. Infrastructure Navigator Architecture Diagram

Components of Infrastructure Navigator

A component is a software or software design with a well-defined interface. A component represents specific behavior of the system.

The following table lists and describes principal components of Infrastructure Navigator.
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server in Infrastructure Navigator virtual machine</td>
<td>The Server component reconciles the data from Active Discovery and transfers the data to the Database component.</td>
</tr>
<tr>
<td>Database in Infrastructure Navigator virtual machine</td>
<td>The Database component stores the data received from the Server component. The Database component also stores Infrastructure Navigator configurations. <strong>Note</strong>: Infrastructure Navigator does not support storing of data in an external database.</td>
</tr>
<tr>
<td>Infrastructure Navigator Plug-In in the vSphere Web Client</td>
<td>The Infrastructure Navigator Plug-In in the vSphere Web Client provides a graphical user interface that you use to view and analyze dependencies.</td>
</tr>
</tbody>
</table>
Installing Infrastructure Navigator

Infrastructure Navigator is a virtual appliance that can run in a VMWare virtual infrastructure. You must ensure that your environment meets requirements so that you can deploy and use the Infrastructure Navigator virtual appliance.

This chapter includes the following topics:

- “Register vCenter Server with vSphere Web Client,” on page 11
- “Virtual Machine Requirements,” on page 12
- “Software Requirements for Infrastructure Navigator,” on page 12
- “Infrastructure Navigator Port Requirements,” on page 13
- “Deploy an Infrastructure Navigator Virtual Appliance,” on page 13

Register vCenter Server with vSphere Web Client

You must register the vCenter Server with the vSphere Web Client so that you do not get an error when you start the vSphere Web Client for the first time.

Prerequisites

- Log in to the system on which the vSphere Web Client is installed using remote desktop.

  **NOTE** You cannot register a vCenter Server system with the client from a remote system.

- If you use the server IP address to access the vSphere Web Client and if your browser uses a proxy, add the server IP address to the list of proxy exceptions.

Procedure

1. Open a Web browser and go to either of the following URLs.

   **Note** Use the localhost or loopback address instead of the server IP address if you want to access the administration tool.

   - https://localhost:9443/admin-app
   - https://127.0.0.1:9443/admin-app

   The vSphere Web Client Administration Tool appears.

2. Click **Register vCenter Server**.

3. In the **vCenter Server URL** text box, type the server name or IP address of the vCenter Server system. Do not include http:// or https://.
4 Type the user name and password for the vCenter Server system.
5 Click Register.

If the credentials are valid, registration process is complete.

You can now use this instance of the Web Client to log in to the vCenter Server system. After the registration is complete, you can open the vSphere Web Client by clicking https://localhost:9443/vsphere-client/.

**Virtual Machine Requirements**

You must meet certain requirements before you start deploying the Infrastructure Navigator virtual appliance on the vSphere Client.

**Table 2-1. Virtual Machine Requirements**

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2 vCPU</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB</td>
</tr>
<tr>
<td>Disk size</td>
<td>20 GB</td>
</tr>
<tr>
<td>Network</td>
<td>1 Gbps</td>
</tr>
</tbody>
</table>

Additionally, you also need Infrastructure Navigator OVA to be deployed on the vCenter Server and predefined static IP pool on desired port groups.

**Software Requirements for Infrastructure Navigator**

You must also meet certain software requirements before you proceed with the deployment of Infrastructure Navigator virtual appliance.

**Table 2-2. Software Requirements**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Virtual Infrastructure 5.0 | vCenter Server 5.0 (build 455964 or later)  
Following ESX/ESXi versions are supported:  
- Version 3.5 (build 425420)  
- Version 4.0 (build 398348)  
- Version 4.1 (build 433742)  
- Version 5.x (all builds are valid) |
| vSphere Web Client    | vSphere Web Client 5.0 (build 423753 or later). Also, vCenter Server registered with vSphere Web Client. For more information about how to register vCenter Server with vSphere Web Client, see “Register vCenter Server with vSphere Web Client,” on page 11. |
| Virtual Center        | Virtual Center IP address and administrator credentials. |
| Web browser           | Internet Explorer or Firefox version that supports Flash version 10. |
| Remote desktop        | Remote desktop access to the Virtual Center with installed Web browser. |
Infrastructure Navigator Port Requirements

Infrastructure Navigator requires certain TCP ports to be open for access requirements.

Table 2-3. Port Requirements

<table>
<thead>
<tr>
<th>Port number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From your PC to Infrastructure Navigator (configure Infrastructure Navigator)</strong></td>
<td></td>
</tr>
<tr>
<td>5480</td>
<td>For appliance Web console</td>
</tr>
<tr>
<td>5489</td>
<td>To communicate with VMware Update Manager (VUM). <strong>Note</strong>: This port is only used in the environment where VUM is installed.</td>
</tr>
<tr>
<td>22</td>
<td>To enable SSH access to the Infrastructure Navigator virtual appliance.</td>
</tr>
<tr>
<td><strong>vCenter Server to Infrastructure Navigator</strong></td>
<td></td>
</tr>
<tr>
<td>2868</td>
<td>For plug-in download. This download happens as part of the registration process.</td>
</tr>
<tr>
<td>6969</td>
<td>For connectivity from vSphere Web Client to Infrastructure Navigator.</td>
</tr>
<tr>
<td><strong>Infrastructure Navigator to vCenter Server</strong></td>
<td></td>
</tr>
<tr>
<td>443</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>80</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td><strong>Infrastructure Navigator to target hosts and virtual machines</strong></td>
<td></td>
</tr>
<tr>
<td>443</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
<tr>
<td>902</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
</tbody>
</table>

Deploy an Infrastructure Navigator Virtual Appliance

You can use the vSphere Client user interface to deploy the Infrastructure Navigator virtual appliance. VMware provides the appliance in an OVA format. If you have vCenter Server Linked Mode groups in your environment, deploy a separate instance of Infrastructure Navigator for each vCenter Server system.

Prerequisites

- Log in to the vSphere Client as a user with administrator privileges.
- Ensure that the virtual machine meets all requirements as described in “Virtual Machine Requirements,” on page 12 section.
- Configure vCenter Managed IP address so that the Infrastructure Navigator virtual appliance can access the vCenter Server. To configure vCenter Managed IP address in the vSphere Client, navigate to Administration > vCenter Server Settings > Runtime Settings and enter the IP address of the vCenter Server in vCenter Server Managed IP field.
- Download the Infrastructure Navigator virtual appliance files from VMware Web site.

Procedure

1. In the vSphere Client, navigate to File > Deploy OVF Template.
2. Browse to the OVA file and select it and click Next.
3. In the OVF Template Details screen, Click Next and accept End User License Agreement and then click Next.
In the Name and Location screen, type a unique virtual appliance name according to the IT naming convention of your organization, and click Next.

If more than one Datacenter is present, you must select the Datacenter on which you want to deploy the virtual appliance.

If the Host/Cluster screen appears, select the host or cluster where you want to deploy the virtual appliance, and click Next.

If the Resource Pool screen appears, select the resource pool within which you want deploy the virtual appliance, and click Next.

In the Disk Format screen, select Thin Provision as the disk format, and click Next.

The Network Mapping screen appears.

Select a network for the OVA, and click Next.

The Properties screen appears.

Enter the administrative password for the root account in the Enter password field and enter the same password in Confirm password field.

Leave the Default Gateway, DNS, Network 1 IP Address, and Network 1 Netmask parameters blank if you want to acquire these values from DHCP server. You can also manually configure these addresses by using static allocation scheme. For more information about static allocation or dynamic allocation, see “Selecting DHCP or Static Network Addresses,” on page 25. Click Next.

The Configure Service Bindings screen appears.

If you have configured the vCenter Managed IP address, you can proceed ahead with deployment and click Next.

The Ready to Complete screen appears where deployment settings are summarized.

Select Power on after deployment, and then click Finish to confirm the settings and begin the deployment.

The process of deploying the Infrastructure Navigator virtual appliance starts.

The process of deploying the Infrastructure Navigator virtual appliance might take several minutes. After the process is complete, the Infrastructure Navigator OVA is deployed on your vSphere Client. Also, the vCenter Infrastructure Navigator is preparing the environment for discovery message appears in the Tasks & Events tab of the vSphere Client.

What to do next

You must now enter a valid license and start the discovery process. For more information about licensing and starting of the discovery process, see Chapter 3, “Setting Up Infrastructure Navigator,” on page 15. You can also set a network proxy, change the time zone, or configure a static IP address. For more information, see Chapter 5, “Configuring Network Settings and Setting Timezone,” on page 25.
After you deploy Infrastructure Navigator virtual appliance you must first enter a valid license of the Infrastructure Navigator. After you enter a valid license, you can start the application discovery process, set the vCenter Server credentials, and integrate SRM. You can also get the system information and product logs information.

**Note** In Linked Mode, the settings must be done on the vSphere Web Client that the Infrastructure Navigator virtual machine is deployed on.

This chapter includes the following topics:

- “Infrastructure Navigator Licensing,” on page 15
- “Privileges Required for Infrastructure Navigator,” on page 17
- “View System Information,” on page 18
- “Managing Application Discovery,” on page 19
- “Update vCenter Credentials,” on page 20
- “Site Recovery Manager Integration with Infrastructure Navigator,” on page 20
- “Update SRM Administrator Credentials,” on page 21
- “Creating Product Support Package,” on page 21
- “Upgrading Infrastructure Navigator Knowledge Base,” on page 21
- “Infrastructure Navigator Log Files,” on page 22

**Infrastructure Navigator Licensing**

If you deploy the Infrastructure Navigator virtual appliance on the vCenter Server, the virtual appliance is deployed without a license key. As a result, application discovery is disabled. You must enter a valid license key to start the application discovery process.

After you enter a valid license key, the Infrastructure Navigator monitors the number of virtual machines discovered by Infrastructure Navigator with regards to the number of virtual machines allowed. You can acquire a license depending on the number of virtual machines and applications running in your environment.
Licensing in Linked Mode Environment

To enable the discovery process, you must enter the license key for all the instances of Infrastructure Navigator in a Linked Mode environment under the licensing section of vSphere Client.

In a Linked Mode environment, you might encounter two possible situations while entering license key for the Infrastructure Navigator virtual appliance.

- If you log in to any of the vCenter Server that is in Linked Mode and if it displays all instances of Infrastructure Navigator in the licensing screen, you need only single login to apply the licenses.
- If you log in to the vCenter Server that is in Linked Mode and if it displays the instance of Infrastructure Navigator specific to that particular vCenter Server, a separate login is needed for every vCenter Server that has an Infrastructure Navigator instance.

Apply Infrastructure Navigator License

Infrastructure Navigator virtual appliance is deployed without a license key. Apply the license key to start the application discovery process.

Prerequisites

Deploy the Infrastructure Navigator virtual appliance on the vCenter Server.

Procedure

1. Log in to the vSphere client as an administrator.
2. Navigate to View > Administration > Licensing.
   
   The licensing window appears.
3. Select the Asset check box.
   
   The Infrastructure Navigator virtual appliance is listed.
4. Double-click the Infrastructure Navigator virtual appliance.
   
   The Assign License: VMware Infrastructure Navigator window appears.
5. Select the Assign a new license key to this solution check box.
6. Click Enter Key.
   
   The Add License Key window appears.
7. Type a valid license key and an optional label for the new license key and click OK.
   
   The license key is displayed.
8. Click OK.

The license key is applied for the Infrastructure Navigator virtual appliance. You can now start the discovery process.
Evaluation License for Infrastructure Navigator

The evaluation license of Infrastructure Navigator is time based and is preset to expire in 30 days. If you apply an evaluation license for Infrastructure Navigator, every time you log in to the vSphere client and vSphere Web Client, an alert warning with the number of days left for the license to expire is displayed.

You can apply an evaluation license by using the vSphere Client as described in “Apply Infrastructure Navigator License,” on page 16. After you apply an evaluation license, the Start Discovery button in vSphere Web Client is enabled, but the discovery is not started, and a message that asks you to apply a license no longer appears. If an evaluation license expires and you have not disabled or uninstalled Infrastructure Navigator, an alert warning that the license has expired is displayed. However, even after the license expires, the Infrastructure Navigator plug-in is not disabled. The discovery process is not affected by expiration of the license and you can still view and manage the information presented by Infrastructure Navigator.

Privileges Required for Infrastructure Navigator

You must log in to vSphere Web Client as an administrator to use the services offered by Infrastructure Navigator.

An administrator is a user that is assigned the administrator role on the vCenter Server or a user in a group that is assigned the administrators role on the vCenter Server. A user or group must be assigned the administrator role on the root folder and all the child objects that are propagating from root folder.

Assign Administrator Privileges

To view services offered by Infrastructure Navigator when you log in to vSphere Web Client, you must assign administrative privileges to the user or group on the root folder and all the child objects that are propagating from the root folder in vSphere Client. Also, in a Linked Mode environment, you must assign administrative privileges to the user or group on the root folder and all the child objects that are propagating from the root folder in all the vCenter Server systems that are in Linked Mode.

Procedure

1. Log in to the vSphere client.
2. On the vCenter entity root level, right-click and select Add Permission.
   The Assign Permissions window appears.
3. Select Administrator from the Assigned Role drop-down menu.
   This menu displays all the roles that are assigned to the object. When the role appears, the privileges contained in the role are listed in the section below the role title.
4. Select Propagate to Child Objects.
5. Click Add.
   The Select Users and Groups window appears.
6. Select the domain where the user or group is located from the Domain drop-down menu.
7. Type a name in the Search box or select a name from the Name list.
8. Click Add.
   The name is added to the Users or Groups list.
9. Repeat steps Step 6 through Step 8 to add additional users or groups.
10. Click OK.
11. To finish the task, click OK.
The server adds administrator privileges to the user.

**Minimal Privileges for Discovery**

To accommodate security needs Infrastructure Navigator supports some minimally privileged users. These users cannot log in into the vSphere Web client, but their credentials can be used to start the discovery process on the Administration screen of the vSphere Web Client.

Infrastructure Navigator necessitates users to have administrative privileges. For more information, see “Privileges Required for Infrastructure Navigator,” on page 17, but to accommodate security needs, Infrastructure Navigator also supports some minimally privileged users. For more information, see “Creating a Role with Minimal Privileges to Enable the Discovery,” on page 18.

**Creating a Role with Minimal Privileges to Enable the Discovery**

You can create a role with Acquire guest control ticket and Console interaction privileges. After you create a role, you must assign a user to this role on the entire datacenter by assigning the user to the root folder and all the child objects that are propagating from the root folder in vSphere Client.

**Procedure**

1. Log in to the vSphere client as an administrator.
2. From the **View** menu, navigate to, **Administration > Roles**.
   
   The Roles screen appears.
3. Click **Add Role**.

   The Add New Role window appears.
4. Navigate to **Virtual machine > Interaction**.
5. Select **Acquire guest control ticket** and **Console interaction** check boxes.
6. Type a name in the **Name** text box.
7. Click **OK**.

A role is created with Acquire guest control ticket and Console interaction privileges. You can now go ahead and assign a user to this role by selecting this role as a role in “Assign Administrator Privileges,” on page 17 procedure. After the completion of the procedure, the user has required privileges to enable the discovery process on the Administration screen of the vSphere Web Client.

**View System Information**

The Administration page displays the product version and knowledge base version of the Infrastructure Navigator virtual appliance. This page also displays the build number of the Infrastructure Navigator virtual appliance that you are currently using.

**Procedure**

1. Log in to the vSphere Web Client as an administrator.
2. On the **vCenter Management** menu, navigate to **System Administration > Navigator**.

   The Administration screen that has the system information appears.

---

**Note** The last number in product version and knowledge base version does not match, but the build number must match.
Managing Application Discovery

The Administration screen of Infrastructure Navigator provides the functionality to manage the application discovery process. You can start the application discovery process to retrieve information about the applications running in your environment.

Start Application Discovery

Infrastructure Navigator utilizes VMware tools to access the virtual machines. Start the application discovery process to retrieve the information about the applications running in your vCenter environment.

Prerequisites

- Ensure that you have entered the license for the Infrastructure Navigator virtual appliance. For more information, see “Infrastructure Navigator Licensing,” on page 15.
- Ensure that you required privileges to start the discovery process. For more information, see “Privileges Required for Infrastructure Navigator,” on page 17.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator.
   The Administration screen appears.
3. Click Start Discovery.
   The Enter vCenter administrator credentials window appears.
4. Type the user name and password and click OK.
   You need to provide the vCenter Server administrator credentials or the privileges described in “Minimal Privileges for Discovery,” on page 18 if you are starting the application discovery for the first time.
   If the credentials are valid, Infrastructure Navigator starts the discovery of all the applications in your environment and the message Application Discovery is running is displayed.

   **NOTE** After the discovery starts, the vCenter Infrastructure Navigator is discovering message appears in the vSphere Client.

Stop Application Discovery

You can stop the application discovery process and to ensure all the discovery actions performed by Infrastructure Navigator is stopped.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator.
   The Administration screen appears.
3. Click Stop Discovery.
   Infrastructure Navigator stops the application discovery process and the message Application Discovery is stopped is displayed.
Update vCenter Credentials

If you have changed or modified credentials of the administrator or minimally privileged user, you must update these credentials on the Administration page of the Infrastructure Navigator virtual appliance in the vSphere Web Client.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator. The Administration screen appears.
3. Click the [user: <user name>] link. The Enter vCenter administrator credentials window appears.
4. Type the user name and password and click OK.
   If the credentials are valid, Infrastructure Navigator updates the credentials successfully.

Site Recovery Manager Integration with Infrastructure Navigator

The Site Recovery Manager (SRM) integration with Infrastructure Navigator displays the SRM Protection Groups and SRM Recovery Plans of the selected virtual machine.

Start SRM Integration

Start the SRM integration to display the vCenter Site Recovery Manager information in the inventory table and dependency map.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator. The Administration screen appears.
3. Click Turn On Integration. The Enter vCenter Site Recovery Manager administrator credentials window appears.
4. Type the user name and password and click OK.
   You need to provide the SRM administrator credentials if you are starting the integration for the first time.
   If the credentials are valid, integration of SRM is started and the message Integration is on is displayed.

Stop SRM Integration

Stop SRM integration to remove all columns and indicators of SRM from the Infrastructure Navigator screen.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator. The Administration screen appears.
3. Click Turn Off Integration. Infrastructure Navigator stops SRM integration and the message Integration is off is displayed.
Update SRM Administrator Credentials

If you have changed SRM credentials, you must update the credentials on the Administration page of the Infrastructure Navigator virtual appliance in the vSphere Web Client.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator.
   The Administration screen appears.
3. Click the [user: <user name>] link.
   The Enter Site Recovery Manager administrator credentials window appears.
4. Type the user name and password and click OK.
   If the credentials are valid, Infrastructure Navigator updates the credentials successfully.

Creating Product Support Package

You can use the Infrastructure Navigator product support package to get system information and product logs information.

Procedure

1. Connect to the Infrastructure Navigator virtual machine through SSH.
2. Navigate to /opt/vadm-engine/bin/ by running the cd /opt/vadm-engine/bin/ command.
3. Create the product support package by running the ./support_package.sh command.

A vadm_server_support_package_* .tgz file is created and is stored in /opt/vadm-engine/bin/ folder.

Upgrading Infrastructure Navigator Knowledge Base

You can update the Infrastructure Navigator knowledge base with new updates without installing a new Infrastructure Navigator virtual appliance.

Prerequisites

The new knowledge base JAR file must be present under the /opt/vadm-activecollector/bin directory.

Procedure

1. Connect to the Infrastructure Navigator virtual machine through SSH.
2. Navigate to /opt/vadm-activecollector/bin by running the command.
   cd /opt/vadm-activecollector/bin
3. Run the command.
   ./update_kb.sh new_knowledge_base_filename.jar
   The update procedure takes between one to two minutes to finish.
4. (Optional) You can verify the progress by running commands.
   tail -f /var/log/vadm/engine.log, tail -f /var/log/vadm/activecollector.log, ll /opt/vadm-activecollector/lib, and ll /opt/vadm-activecollector/tmp
The Infrastructure Navigator knowledge base is updated.

**Note** If you want to restore the knowledge base to any previous version, you have to download the knowledge base JAR file from the knowledge base product site matching the original Infrastructure Navigator virtual appliance version and run an upgrade on it to upgrade back to the previous knowledge base.

## Infrastructure Navigator Log Files

All Infrastructure Navigator log files are located in `/var/log/vadm/`. The following table lists all the generic log files that are available in Infrastructure Navigator.

### Table 3-1. Generic Log Files

<table>
<thead>
<tr>
<th>Generic Logs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activecollector.log</td>
<td>The active collector log file</td>
</tr>
<tr>
<td>dbconfig.log</td>
<td>The database operations log file</td>
</tr>
<tr>
<td>engine.log</td>
<td>The engine log file</td>
</tr>
<tr>
<td>listener.log</td>
<td>The listener log file</td>
</tr>
<tr>
<td>engine.catalina.log</td>
<td>Internal tserv log file</td>
</tr>
<tr>
<td>db/postgresql.log</td>
<td>PostgreSQL log file</td>
</tr>
<tr>
<td>kb-update.log</td>
<td>Logs knowledge base update</td>
</tr>
<tr>
<td>update.log</td>
<td>Logs the virtual appliance updates</td>
</tr>
</tbody>
</table>

The following table lists the service log files available in Infrastructure Navigator.

### Table 3-2. Services Log Files

<table>
<thead>
<tr>
<th>Services Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activecollector.stdout</td>
<td>For the active collector services</td>
</tr>
<tr>
<td>listener.stdout</td>
<td>For the listener services</td>
</tr>
<tr>
<td>engine.catalina-out.log</td>
<td>For the engine services</td>
</tr>
</tbody>
</table>

The vSphere Web Client log file is located on the vSphere Web Client server at `C:\Program Files\VMware\Infrastructure\vSphere Web Client\OMServer\serviceability\logs\log.txt`.  


Security Overview

Infrastructure Navigator offers strong network security to protect sensitive corporate data. The Infrastructure Navigator plug-in leverages the vCenter Server for authentication and eliminates the user management requirement.

Infrastructure Navigator uses PostgreSQL as the database and other individual process that are limited to a single virtual appliance. This limit reduces the vulnerability of the system by allowing the components to perform inter-process communication on the local protected channels.

This chapter includes the following topics:

- “Firewall for Infrastructure Navigator,” on page 23
- “Protecting Sensitive Files,” on page 24
- “Securing Infrastructure Navigator,” on page 24

Firewall for Infrastructure Navigator

Infrastructure Navigator uses the SLES, SuSEfirewall2 firewall. Infrastructure Navigator requires certain TCP ports to be open for proper operation of the product.

The firewall is configured so that Infrastructure Navigator can use the following ports.

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5480</td>
<td>For appliance Web console.</td>
</tr>
<tr>
<td>5489</td>
<td>To communicate with VMware Update Manager (VUM). <strong>Note</strong> This port is only used in the environment where VUM is installed.</td>
</tr>
<tr>
<td>22</td>
<td>To enable SSH access to the Infrastructure Navigator virtual appliance.</td>
</tr>
<tr>
<td>80</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>2868</td>
<td>For plug-in download. This download happens as part of the registration process.</td>
</tr>
<tr>
<td>6969</td>
<td>For connectivity from vSphere Web Client to Infrastructure Navigator.</td>
</tr>
</tbody>
</table>

The firewall is started during the first boot of the operating system. To stop the firewall, monitor its status, and start the firewall, you can use the following commands.
<table>
<thead>
<tr>
<th>Operation</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>stop</td>
<td>/etc/init.d/SuSEfirewall2_setup stop</td>
</tr>
<tr>
<td>status</td>
<td>/etc/init.d/SuSEfirewall2_setup status</td>
</tr>
<tr>
<td>start</td>
<td>/etc/init.d/SuSEfirewall2_setup start</td>
</tr>
</tbody>
</table>

### Protecting Sensitive Files

Infrastructure Navigator has some sensitive files that must be protected from unauthorised access as that might compromise Infrastructure Navigator security.

The `vadm.keystore` file, found under `/opt/vadm-engine/conf/` is a critical file that contains private key and certificate of the application. Unauthorized access to this file might give an attacker access to the Infrastructure Navigator database.

The `vadm.keystore` file is protected by access controls. Do not change the permissions on the file or folder as it might either give too much access, reduce security, or restrict access, thereby preventing Infrastructure Navigator from working.

For the access controls to work properly, access to the Infrastructure Navigator virtual appliance must be strictly limited to those with a need to log in, with the minimal levels of access required. This involves limiting the use of the root account. Any backups of the Infrastructure Navigator virtual appliance must be strictly protected and encrypted with the keys managed separately from the backups.

### Securing Infrastructure Navigator

Infrastructure Navigator uses digital certificates to enable secure communication based on Transport Layer Security (TLS).

TLS is based on the Secure Sockets Layer (SSL) specifications developed by Netscape Communications and has been standardized by the Internet Engineering Task Force (IETF). TLS provides privacy of communication by using encryption and also allows you to verify the authenticity of the server with which you are communicating.

During the first boot of the appliance, a self-signed certificate is generated. This certificate is used for encrypted TLS communication between the Infrastructure Navigator virtual appliance and the vSphere Web Client.
After deploying the Infrastructure Navigator appliance, you can configure several options by using a VMware console window.

You can use the options on the Console tab of the vSphere Client to perform the following functions.

- Login
- Configure Network
- Set timezone

This chapter includes the following topics:

- “Selecting DHCP or Static Network Addresses,” on page 25
- “Configuring Static IP Address,” on page 26
- “Setting the Default Gateway,” on page 26
- “Setting the DNS Servers,” on page 26
- “Setting the Host Name,” on page 27
- “Configuring the Network Proxy,” on page 27
- “Configuring DHCP,” on page 27
- “Setting the Time Zone,” on page 28
- “Log in to the Infrastructure Navigator Web Console,” on page 28
- “Using Infrastructure Navigator Web Console,” on page 29

### Selecting DHCP or Static Network Addresses

You can select whether you want to manually configure the network addresses by static allocation or use the DHCP server to dynamically allocate the addresses.

DHCP server allocates temporary IP address at the time of deployment process. As the DHCP address is temporary, it might be different if the virtual appliance is powered off for a long time before you power it on again. The time period depends on DHCP lease expiration. You can configure the Infrastructure Navigator virtual appliance to use a static address, which remains the same after restart. A static IP address allows all users of the appliance to be certain of its network address and associated host name so they can connect to it predictably.
Configuring Static IP Address

You can configure the static IP address for your Infrastructure Navigator virtual appliance. A static IP address allows all users of the appliance to be certain of its network address so they can connect to it predictably.

**Procedure**

1. Navigate to the console tab of your virtual appliance, select **Configure Network** and press Enter.
   
   If the Console screen is not visible, press Ctrl+D.
   
   A network interface configuration menu appears.

2. Type the menu number to configure IP address allocation for the network interface.

3. A message to configure IPv4 address appears. Type `y`. A message that asks you to use DHCP server instead of static IPv4 address appears.

4. Type `n`. On subsequent lines, enter the static IPv4 address and netmask in dotted decimal notation.
   
   A confirmation message appears.

5. Type `y`. The static IP address is configured for the Infrastructure Navigator virtual appliance.

You also need to configure default gateway, host name, and DNS servers.

Setting the Default Gateway

The gateway, or router, mediates between the local subnet and other networks. If you configure static IP address, you must set the default gateway.

**Procedure**

1. Navigate to the **Console** tab of your virtual appliance, select **Configure Network** and press Enter.
   
   If the Console screen is not visible, you can press Ctrl+D to view it.
   
   A network interface configuration menu appears.

2. Type the number associated with configuration of default gateway.

3. Select the interface that you want to associate with default gateway and press Enter.

4. Type the IPv4 address of the default gateway for the network interface and press Enter.
   
   If the parameters are correct, the default gateway is set for the network interface.

Setting the DNS Servers

The DNS is a standard technology for managing the names of Web sites and other Internet domains. If you configure static IP address, you must set the DNS servers.

**Procedure**

1. Navigate to the **Console** tab of your virtual appliance, select **Configure Network** and press Enter.
   
   If the Console screen is not visible, press Ctrl+D.
   
   A network interface configuration menu appears.

2. Type the number associated with DNS setting.
3 Type the IPv4 address of the primary DNS server.
   A secondary DNS server is optional but recommended.
   If the parameters are correct, the DNS server is set.

Setting the Host Name

A host name is a label that is assigned to a device connected to a computer network. If you configure static IP address, you must set the host name.

Procedure
1 Navigate to the Console tab of your virtual appliance, select Configure Network and press Enter.
   If the Console screen is not visible, press Ctrl+D.
   A network interface configuration menu appears.
2 Type the number associated with setting of host name.
3 Type the host name for the virtual appliance.
   If the parameters are correct, the host name is set for the network interface.

Configuring the Network Proxy

By default, Infrastructure Navigator assumes that it has a direct connection to the Internet. If HTTP and other protocols go through a network proxy server you need to configure network proxy.

Procedure
1 Navigate to the Console tab of your virtual appliance, select Configure Network and press Enter.
   If the Console screen is not visible, press Ctrl+D.
   A network interface configuration menu appears.
2 Type the number associated with setting of proxy server. A message Is an IPv4 proxy server necessary to reach the Internet? appears.
3 Press y, and then type the network address either an IP address or host name with dotted domain and port number of the proxy server.
   If the parameters are correct, the network proxy is set.

Configuring DHCP

You can reconfigure your Infrastructure Navigator virtual appliance IP address to use DHCP if you have not configured the DHCP at the time of deployment of the virtual appliance.

Procedure
1 Navigate to the console tab of your virtual appliance, select Configure Network, and press Enter.
   If the Console screen is not visible, press Ctrl+D.
   A network interface configuration menu appears.
2 Type the menu number to configure IP address allocation for the network interface.
3 Type y to configure an IPv4 address.
4 Type y to use a DHCP server instead of a static IPv4 address.
   The IPv4 address and netmask assignment are automatic.
Type y. The DHCP server allocates the IP address and takes you back to the network interface configuration menu.

**Setting the Time Zone**

You can change the time zone for the Infrastructure Navigator virtual appliance to reflect the time zone of your region or country.

**Procedure**

1. On the **Console** tab of the virtual appliance, select **Set Time zone** and press Enter.
   
   If the Console screen is not visible, press Ctrl-D.

2. In the Please identify a location screen, select your continent or ocean and press Enter.

3. In the country screen, select your region or country and press Enter.

The time zone of the county selected is displayed and you are asked for confirmation. If you validate the selection, the time zone of that particular country is set.

*NOTE* The last successful discovery time field exported to the inventory service process on Infrastructure Navigator is in time zone defined for Infrastructure Navigator virtual appliance. If you want to change time zone of Infrastructure Navigator, see “Set Time Zone by Using Infrastructure Navigator Web Console,” on page 29.

**Log in to the Infrastructure Navigator Web Console**

You can change the network settings, shut down the virtual appliance, and reboot the virtual appliance after logging in to the Infrastructure Navigator Web console.

**Prerequisites**

- You must have deployed the Infrastructure Navigator virtual appliance on the vSphere Client.
- You must have port 5480 open for communication.

**Procedure**

1. In your Web browser, type the IP address of the virtual appliance that you have deployed on your vSphere Client (for example, `https://InfrastructureNavigator-VM-IP:5480`).

   The Infrastructure Navigator login page appears.

2. Type the user name and password of the virtual appliance and click **Login**.

A System Information page that summarizes the system information of Infrastructure Navigator virtual appliance appears.
Using Infrastructure Navigator Web Console

You can use the Infrastructure Navigator Web Console to change network settings, shut down, and reboot of the Infrastructure Navigator virtual appliance.

Restart or Shut Down Infrastructure Navigator Virtual Appliance

You can restart or shut down the Infrastructure Navigator virtual appliance from the Information page. This page also provides information of virtual appliance vendor, appliance name, appliance version, computer host name, operating system name, operating system version, and OVF environment (if any).

Procedure

1. Log in to the Infrastructure Navigator virtual appliance Web console.
2. Click the System tab in the Web console.
   - The Reboot and Shutdown buttons are under the Actions heading on the right side of the window.
3. To stop the virtual appliance, click Shutdown.
4. To restart the virtual appliance, click Reboot.

Set Time Zone by Using Infrastructure Navigator Web Console

You can change the time zone for the Infrastructure Navigator virtual appliance to reflect the time zone of your region or country. You can also change the time zone by selecting the time zone from the drop-down list in the Infrastructure Navigator Web console.

Procedure

1. Log in to the Infrastructure Navigator Web console.
2. On the System tab of the Web console, click Time Zone.
3. From the drop-down menu, select among time zones of the world.
4. Change the time zone if you did not already do on the appliance console.
5. Click Save Settings to reflect the change.
   - If you do not set the time zone explicitly, the default is UTC, Coordinated Universal Time.

Configuring Network by Using Infrastructure Navigator Web Console

From the Network tab in the Web console you can check the status of the network by using the Status tab, change the configuration of the network by using the Address tab, and configure a proxy server by using the Proxy tab.

Status

Shows the network information, such as the host name, gateways, DNS servers, network interface name for multiple network interface cards. This page also provides information about the IPv4 address, the netmask, whether DHCP is used for IPv4. If you make any changes to the network, you can click Refresh to obtain current status.

Address

You can specify IP network information and enable DHCP services. If you change any network address settings, you must click Save Settings to reflect your changes.
When the IPv4 address type is set to DHCP, the virtual appliance gets its network settings from your DHCPv4 server. If you set the IPv4 address type to **Static**, you must enter some values and some values are auto-populated, although you can change these values to the values of your choice.

- **Hostname**: Host name of the virtual appliance. The host name is auto-populated.
- **IPv4 Default Gateway**: IPv4 address of the gateway. This address is auto-populated.
- **Preferred DNS Server**: IPv4 address of the primary DNS server. This address is auto-populated.
- **Alternate DNS Server**: IPv4 address of the secondary DNS server.
- **IPv4 Address Type**: IPv4 address type of the virtual appliance that you have selected as Static.
- **IPv4 Address**: IPv4 address of the virtual appliance. Enter the IPv4 address of your choice.
- **Netmask**: Network mask for the virtual appliance. Enter the netmask address of your choice.

**Proxy**

Allows you to specify a proxy server and a proxy port for accessing external network. You must click **Save Settings** to accept the changes that you make to the proxy settings. You can configure a network proxy from this interface. If you select the **Use a Proxy Server**, you must specify a proxy server and proxy port. The user name and proxy password are optional.

- **HTTP Proxy Server**: Host name or IP address for the proxy server.
- **Proxy Port**: Proxy server communications port.
- **Proxy Username**: A valid user name, if the proxy server requires authentication.
- **Proxy Password**: A valid password, if the proxy server requires authentication.
You can upgrade Infrastructure Navigator virtual appliance without needing to redeploy virtual appliance again. Such an upgrade applies to Infrastructure Navigator Red Hat Package Manager (RPM) and third-party RPMs like RabbitMQ.

**Note** You must take a snapshot of the Infrastructure Navigator virtual appliance before you run the upgrade procedure. If any problems occur with virtual appliance after the upgrade, you can revert back to the snapshot.

This chapter includes the following topics:
- “Infrastructure Navigator Upgrade,” on page 31
- “Upgrade Infrastructure Navigator by Using Web Console,” on page 32
- “Upgrade Limitation for Infrastructure Navigator,” on page 32

**Infrastructure Navigator Upgrade**

Infrastructure Navigator 1.1 and later can be upgraded to the higher version by using the Infrastructure Navigator Web console. You can use the Update tab in the Infrastructure Navigator Web console to upgrade the Infrastructure Navigator virtual appliance.

**Note** Infrastructure Navigator does not support upgrade through VMware Update Manager (VUM).

The Settings tab shows the setting of policies for periodically checking and installing Infrastructure Navigator virtual appliance updates.

**Table 6-1. Update Policies**

<table>
<thead>
<tr>
<th>Update Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No automatic updates</td>
<td>This check box is selected by default. The virtual appliance does not check and install updates.</td>
</tr>
<tr>
<td>Automatic check for updates</td>
<td>The virtual appliance checks for updates at the scheduled time. If an update is available, it appears on the Update Status page.</td>
</tr>
<tr>
<td>Automatic check and install updates</td>
<td>The virtual appliance checks for updates at the scheduled time, and if updates are available, installs them.</td>
</tr>
</tbody>
</table>

If you select either Automatic check for updates or Automatic check and install updates, you can configure the scheduling. By default, the check occurs daily at 3:00 a.m. local time, as determined by your time zone setting.

By default, Infrastructure Navigator updates from the VMware vapp-updates Web site. You can choose instead to update from a CD-ROM or from an alternative update repository URL.
Upgrade Infrastructure Navigator by Using Web Console

You can upgrade the Infrastructure Navigator virtual appliance by using the Infrastructure Navigator Web console. The upgrade procedure upgrades the virtual appliance RPMs to another build version.

Procedure

1. Log in to the Infrastructure Navigator Web console.

2. Click the Update tab.

   The current status of Infrastructure Navigator virtual appliance is displayed.

3. Click Check Updates.

   The available updates are listed.

4. Click Install Updates.

   A message confirms that the update is in progress. After a successful update, the Status tab displays the Last Check and Last Update information.

5. Restart the vSphere Web Client service on the vCenter Server after you perform the update procedure.

Upgrade Limitation for Infrastructure Navigator

Some limitations are associated with the upgrading of the Infrastructure Navigator virtual appliance. You must keep these limitations in mind before upgrading the virtual appliance.

- No downgrade is possible after you perform the upgrade procedure. Consider taking a snapshot of the Infrastructure Navigator virtual appliance before you run the upgrade procedure.

- When using a Web console of Infrastructure Navigator virtual appliance, you can only upgrade to the available higher version.

- No authentication or access control mechanism is available to the catalog.

- After an upgrade, the Navigator tab is available only after you restart the vSphere Web Client service on the vCenter Server.

- During the upgrade procedure, if you try to access the Navigator tab in the vSphere Web Client, you might see a communication error message because during the upgrade the engine stops working.
Perform the uninstall process if you want to remove the Infrastructure Navigator plug-in from the vCenter Server.

Uninstall Infrastructure Navigator Plug-in

Uninstall procedure removes the plug-in from the vCenter Server.

Procedure

1. Log in to vSphere Web Client.
2. On the vCenter Management menu, navigate to System Administration > Navigator.
   The Administration screen appears.
3. Click Uninstall.
   A confirmation message is displayed.
4. Click Yes.
   The uninstall process starts, and might take anywhere between 30 minutes to one hour depending on number of virtual machines and applications running in your environment.

After successful completion of the uninstall procedure the message,

Infrastructure Navigator is not installed on this vCenter Server.
If you are working in Linked Mode, log in to the vCenter Server where Infrastructure Navigator is installed.
If you want to uninstall Infrastructure Navigator, you must restart the vSphere Web Client service to complete the uninstall process. You can then delete the virtual appliance.

is displayed in the vSphere Web Client. Also, the vCenter Infrastructure Navigator is cleaning up message is displayed in the vSphere Client.

What to do next

After you uninstall the Infrastructure Navigator plug-in, you can power off and delete the Infrastructure Navigator virtual machine from the vCenter Server. You need to restart the vSphere Web Client service to enable the installation of new Infrastructure Navigator plug-in in the future.
Troubleshooting Infrastructure Navigator provides information about the problems that you might encounter when using VMware vCenter Infrastructure Navigator and provides possible workarounds.

This chapter includes the following topics:

- "vCenter Certificate Error," on page 35
- "Plug-In Does Not Work in vSphere Web Client After an Upgrade," on page 36
- "Error in Retrieving Information Might Occur," on page 36
- "Incorrect Marking of a Virtual Machine as an External Machine," on page 36
- "Deployment Failure After IP Address Change," on page 37
- "Failure of the Virtual Appliance After DHCP Selection," on page 37
- "VMware Tools Compatibility Error," on page 37
- "Infrastructure Navigator Authentication Failure," on page 37
- "Navigation Problem Between Objects," on page 38
- "Error Because of Single Instance of Infrastructure Navigator," on page 38
- "Navigation Error," on page 38
- "Discovery Failure in Linked Mode," on page 39
- "Error Message in Recent Tasks List," on page 39

vCenter Certificate Error

If you try to manually replace the certificate on the vCenter Server, Infrastructure Navigator is not able to load the new certificate thumbprint.

**Problem**

If you delete the `/opt/vmware/etc/vami/ovfEnv.xml` file, the new file created at restart contains the old certificate's thumbprint.

**Solution**

1. Select a virtual machine and ensure that it is powered off.
2. Right-click the selected virtual machine and select **Edit Settings**.
3. Select the **vServices** tab.
4. Right-click **vCenter Extension vService Dependency** and click **Edit**.
5 Select No Provider from the Provider drop-down menu.
6 Click OK and click OK again.

Solution

Repeat steps 2 through 7 and in step 5 select vCenter Extension vService from the Provider drop-down menu. When you power on the virtual machine next time, its OVF environment is updated with the new vCenter certificate thumbprint.

Plug-In Does Not Work in vSphere Web Client After an Upgrade

If you upgrade to a new Infrastructure Navigator build, the plug-in does not work in vSphere Web Client.

Problem

After you upgrade to a new Infrastructure Navigator build and the log in to the vSphere Web Client, the plug-in does not appear in vSphere Web Client.

Solution

1 Restart the vSphere Web Client service.
2 Wait for five minutes and then log in again into the vSphere Web Client.
   The plug-in is now visible.

Error in Retrieving Information Might Occur

If you restart the Infrastructure Navigator virtual machine or the engine services, an error message is displayed.

Problem

If Infrastructure Navigator is unable to map services that are running on the selected vCenter entity, instead of the total number of services installed, an Error retrieving information from Infrastructure Navigator message is displayed.

Solution

Wait for few minutes and if the problem persists, restart the Infrastructure Navigator virtual appliance.

Incorrect Marking of a Virtual Machine as an External Machine

Infrastructure Navigator might incorrectly mark a virtual machine as an external machine.

Problem

Infrastructure Navigator can incorrectly mark a virtual machine as an external machine under the following conditions:

- Monitored virtual machine is configured with hardware version 4.
- Multiple IPv4 addresses are configured on the virtual machine.
- vCenter displays only one IP address for the virtual machine with hardware version 4, but according to Infrastructure Navigator, the IP address might be different. This issue does not occur with newer hardware versions, for example, hardware version 7 and 8.

Solution

If your virtual machine is located on an ESX 4.x or higher host, right click the powered-off virtual machine and select Upgrade Virtual Hardware.
Deployment Failure After IP Address Change

You cannot deploy the Infrastructure Navigator plug-in after you change the IP address of the Infrastructure Navigator virtual appliance.

Problem
If you change the IP address of the Infrastructure Navigator virtual appliance, the Infrastructure Navigator plug-in fails to deploy in the vSphere Web Client.

Solution
After the IP address change, restart the Infrastructure Navigator virtual appliance.

Failure of the Virtual Appliance After DHCP Selection

The Infrastructure Navigator virtual appliance does not work if you assign the IP address by using DHCP.

Problem
During the deployment of Infrastructure Navigator virtual appliance, if you assign the IP address to the Infrastructure Navigator virtual appliance by using DHCP, the virtual appliance does not work properly.

Solution
Restart the Infrastructure Navigator virtual appliance and the vSphere Web Client.

VMware Tools Compatibility Error

Virtual machine discovery might fail because of a VMware tools compatibility error.

Problem
If you attempt to discover virtual machines with a VMware Tools version lower than the one compatible with ESX host version 3.5, the discovery might fail with the error message Unknown discovery error.

Solution
Update VMware tools.

Infrastructure Navigator Authentication Failure

The Infrastructure Navigator plug-in does not appear in the vSphere Web Client after you restart vCenter Server.

Problem
After you restart vCenter Server, the vCenter Server fails to authenticate the Infrastructure Navigator plug-in and hence the Navigator tab does not appear in vSphere Web Client.

Solution
Restart Infrastructure Navigator after you restart vCenter Server.
Navigation Problem Between Objects

Problem occurs when you navigate from one object to another in the left pane in the vSphere Web Client or when you navigate from the dependency map of one virtual machine to the dependency map of another virtual machine.

**Problem**

When you navigate from one object to another in the left pane in the vSphere Web Client or when you navigate from the dependency map of one virtual machine to the dependency map of another virtual machine, the **Loading...** message might persist for a very long time in the user interface.

**Solution**

Navigate to a different object in the left pane or reload the vSphere Web Client.

Error Because of Single Instance of Infrastructure Navigator

Sometimes in a Linked Mode environment errors appear in the user interface if only one instance of Infrastructure Navigator virtual appliance is deployed on the main vCenter Server.

**Problem**

In a Linked Mode environment, if you log in to the secondary vCenter Server that does not have Infrastructure Navigator deployed and then navigate to the **Navigator** tab of the main vCenter Server, the **Class not found** error message is displayed. This issue might also occur in environment with a single instance of vCenter Server.

**Solution**

Perform one of the following workarounds.

- Deploy an Infrastructure Navigator virtual appliance on secondary vCenter Server as well.
- After you log in to the secondary vCenter Server, do not navigate between vCenter Servers.
- Log in only to the main vCenter Server, which has the Infrastructure Navigator virtual appliance deployed.
- If this issue occurs in a single vCenter Server environment, clear cookies or cache memory of the Web browser and log in again.

Navigation Error

The vSphere Web Client displays an error message if you navigate from the **VMs and Templates** view to the vCenter Server root-level view.

**Problem**

In the vSphere Web Client, if you select the **VMs and Templates** view and navigate first to its folder level, then the Datacenter level, and finally to the vCenter Server root level, the **Navigator** tab displays the **This list is empty** error message.

**Solution**

Refresh the vSphere Web Client page or navigate by using a different sequence to reach the vCenter Server root level.
Discovery Failure in Linked Mode

You might be unable to start the discovery process in a Linked Mode environment after you uninstall an Infrastructure Navigator virtual appliance from one of the vCenter Server instances.

**Problem**

In a Linked Mode environment that has two Infrastructure Navigator virtual appliances deployed with the same version, if you uninstall and then install an Infrastructure Navigator virtual appliance from one of the vCenter Server instances, you cannot start the discovery process in the vSphere Web Client from where you have removed the virtual appliance. Also, the license key is not available on the Asset tab, but is available on the Product tab of the vSphere Client.

**Solution**

Restart the engine.

Error Message in Recent Tasks List

If you log in to a non-English version of the vSphere Client, an error message might appear in the Recent Task list.

**Problem**

After you deploy Infrastructure Navigator on a non-English version of the vSphere Client, the Recent Task list might display a label not found error message. This error message also appears in the Task Console of the vSphere Web Client.

**Cause**

This issue is caused by a VPX i18nfileter limitation on the language fallback mechanism.

**Solution**

For the vCenter Server on a Windows machine:

a Create dummy locale folder under directory C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale in the vCenter Server. For example, C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\de, C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\fr, C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\ja, C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\zh_CN, or C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\ko.

b Copy all the English resource files under C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\en to the locale folders that you have created.

The vCenter Server loads the strings correctly by using the dummy resource files.
For the vCenter Server on a Linux machine:


b Copy all the English resource files under `/usr/lib/vmware-vpx/extensions/com.vmware.vadm/locale/en` to the locale folder that you have created.

The vCenter Server loads the strings correctly by using the dummy resource files.
Index

A
Acquire guest control ticket 18
Active Discovery 8
administrator privileges 18
administrator role 17
application discovery 19
application services 7
applying license 16
architecture 8
audience 5
authentication failure 37

B
benefits 7

C
certificate error 35
certificates 24
compatibility error 37
configurations 8
configuring DHCP 27
Console interaction 18
coordinated universal time 29

D
Database component 8
default gateway 26
DHCP 25
DHCP post requisite 37
discovery failure 39
DNS server 26

E
ESX 12
evaluation license 17

F
firewall 23
functionality 7

G
gateway 29
graphical user interface 8

H
host name 27
hostname 29

I
incorrect marking of a virtual machine 36
Infrastructure Navigator upgrade 32
initiating SRM 20
installing 11
integration 7
IP address change 37

K
knowledge base version 18

L
licensing 15
linked mode error 38
linked mode licensing 16
log files 22
log in 28

M
minimal permission 18
minimal privileges 18

N
navigation error 38
navigation problem 38
netmask 29
network address 26
network proxy 27

O
overview, Infrastructure Navigator 7

P
plug-in 8
plug-in upgrade 36
port requirements 13
privileges 17
privileges to view data 17
product support package 21
product version 18
proxy 29